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1. Introduction 
ProSoft is a data analysis package for processing data collected from oceanographic 
measurement systems. The primary goal of ProSof is to support processing of optical 
data in an automated and consistent manner such that any two investigators can get the 
same results from the same data set. 

With the increasing number of different instrument types that can be used from 
autonomous buoys, ships, or airborne platforms, a demand for a generalized approach 
for processing all optical data has emerged. To meet this demand, ProSoft has been 
created. The most important changes have been related to data and metadata 
organization, which is now based on the Hierarchical Data Format (HDF 4), developed 
by The National Center for Supercomputing Applications at University of Illinois at 
Urbana-Champaign http://HDF.ncsa.uiuc.edu/. At the same time, the principles of data 
processing have not changed. Any principle changes that will be introduced in the future 
will be stated explicitly (they can be found in the program under menu ‘Help->About’). 
ProSoft allows users to read, calibrate, average and inspect data sets collected from 
their instrumentation. 

Check for the latest ProSoft updates at http://satlantic.com/prosoft 
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2. System Requirements 
ProSoft source code is written and compiled using MATLAB® version 6.5.0. 

The minimum system requirements for ProSoft are: 

• Operating System: Microsoft® Windows®  XP/Vista/7/8 

• Processor (CPU): 1 GHz 32-bit (x86) 

• Memory (RAM): 1024 MB 

• Free Disk Space: 100 MB 
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3. Installation 
ProSoft is available for Microsoft® Windows® XP/Vista/7/8 on the CD-ROM supplied 
with your Satlantic instrument or as a single self-extracting installer from: 

http://satlantic.com/prosoft 

Run the ProSoft<version>_Setup.exe program and follow the instructions on the screen. 
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4. Revisions 

4.1 ProSoft 7.7 
1. Changed graphics renderer mode to zbuffer which renders 3-D graphics in much 

less time. 

2. When graphing HDF file data, users are now able to select which independent 
variables to graph as well as the range of the dependent variable. 

3. New graphical overlay option allows users to graph data from different dependent 
variables belonging to the same instrument group onto the same graph. 

4. Any number of ECO Sensor IOP sensors can now be processed for an instrument. 
Most calibration file definitions are acceptable for an ECO Sensor IOP. 

5. Improved reliability of sensor distances from surface and pressure reference 
distances. 

6. Sample delay time correction has now been applied to timer values where 
appropriate at level 2 processing. 

7. Transmissometer sensor has been added to level 2s and 3a data processing. 

8. Added Reference Ef Ev and Ld optical sensors to level 2s and 3a data processing. 

9. Any kind of profiler can now be used in Reference mode. The mode is indicated in 
the instrument context by selecting Reference as the instrument type. 

10. Improved dynamic data processing at levels 2s and 3a. 

11. All GPS telemetry definitions are now supported. 

12. Added the ability to process upcasts and downcasts within the same telemetry file. 

13. ECO Series IOP sensors with backscatter sensors can now process backscattering 
coefficients as a Level 4 data product. 

14. Added new tool that allows conversion of ProSoft generated HDF files into MATAB 
binary files (*.mat) which can be imported directly into the MATAB workspace. 

15. Level 4 chlorophyll profile estimates updated to Morel 2001 model. 

16. Added derived profiler velocity and absolute tilt values to level 2 HDF files. 

17. Added use of the HDF4 limit of 512 data fields for writing Vdata tables to prevent 
invalid HDF files. 

18. Improved the equation used to calculate Ed(0+).    

19. Added the calculation of Q(0-) based on calculated Eu(0-) and Lu(0-) to level 4. 

20. Added the level 4 processing  parameter ET Solar Irradiance. 

21. Added the ability to import processing parameters from a file. 

22. Added support for SAS with SATNAV ancillary sensors to Level 3a 
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4.2 ProSoft 7.6 
1. GPS sensor data integrated into profiler/reference configurations. GPRMC, GPGLL 

and GPGGA only are supported. 

2. TSRB mode added for all profiler/reference configurations including HyperPro II. 

3. Level 4 water properties data product enabled. Instrument must have a profiler with 
Temp and Cond sensors. 

4. Level 2s depth integration resolution is now adjustable to 0.01, 0.02, 0.05 and 0.10m 
through parameters settings. 

5. SAS integration time interval is now derived on the interval of the optical sensor with 
the highest rate instead of the standard of 0.1sec. 

6. Conductivity sensor data included to level 3a. 

7. Temperature sensor data included to level 3a. 

8. Fluorometer sensor data included to level 3a. 

9. File batch processing sequence changed. Instead of processing all files together at 
one level (i.e. process all files at level 1a before processing all files at level 1b), each 
file is processed separately from level 1a to selected level. 

10. Calibration files can now be added or removed from configuration files that are 
created from *.sip files. 

11. Imported configuration files can now be saved with their original file name by clicking 
on 'Save' in the configuration utility. 

12. Reference only or TSRB mode data are now integrated onto the time interval derived 
from the Es sensor instead of the previous standard of 0.1 sec. 

13. Added Reference Ev optical sensor to processing at all levels. 

4.3 ProSoft 7.5 
1. Added support for level 2s GPS integration for the following GPS formats $GPRMC, 

$GPGLL and $GPGGA. 

2. SAS GPS data is now averaged at level 3a. 

3. GPS data is not available for viewing below level 2s in the HDF viewer but can be 
extracted using the ASCII data extractor. 

4. Added support for the ECO Series IOP sensor for the new HyperPro II instrument. 

5. Faster ASCII data extraction of HDF files. 

6. Fixed bugs preventing processing of TSRB data. 

4.4 ProSoft 7.4 
1. Processing parameters have been incorporated into one file. Access to the file is 

through the new processing parameters utility. 
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2. Processing parameters can be easily edited through the new parameters interface. 
All four levels of parameters are viewed and edited at once. 

3. Processing parameters have been separated from the instrument context. The new 
‘Processing Context’ consists of both the current instrument and current processing 
parameters. 

4. HDF viewer now includes the ability to save the graph image as a file using the png 
graphic format. 

5. Updated ProSoft main menu. Processing level commands have been moved to the 
main menu for easier use. Ascii data extractor and HDF viewer are now accessible 
through the menu selection ‘Tools’. 

6. Instrument context creation/edit utility now allows adding or removing calibration files 
from the instrument context. 

4.5 ProSoft 7.3 
1. New level 2s file is introduced for all instruments. The Level 2s file shows the 

interpolated data just prior to averaging at Level 3a. 

2. Introduction of ‘Instrument Context’ creation and loading for easy data processing 
and selection between different instruments. 

3. Added processing support for Satlantic Satnet instruments. 

4. Easier to use Ascii data extraction utility. 

5. Updated ProSoft main menu interface. 

6. Addition of completely revised HDF graphical viewer utility which makes it possible to 
graph all HDF files in 2-D or 3-D graphical views. 

7. Updated and easier to use configuration file creation/edit utility. 

8. Level 4 chlorophyll a profile estimates using Morel 98 model added. 

9. Level 4 chlorophyll a surface estimates using SeaBAM OC2 model (Rrs) added. 

10. Level 4 chlorophyll a surface estimates using Gordon 88 model (Lwn) added. 

11. Level 4 energy profile/surface fluxes added. 

12. SAS data can now be processed to level 3a. 
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Create new instrument context 

Create new parameters 

Edit current instrument context Delete current 
instrument context 

Edit current parameters 

Process data from raw to level 2 

Process data from raw to level 3a 

Process data from raw to level 4 

Process data from raw to level 1a 

Process data from level 1a to level 1b 

Process data 
from level 1b to 
level 2 

Process data from 
level 2s to level 3a Process data from level 3a to level 4 

Delete current 
parameters 

Process data from raw to level 2s 

Import existing  
instrument context 
from a file 

Import existing 
parameters from a file 

Process data from level 2 to level 2s 

5. Overview 

 

5.1 Processing Context 
The processing context defines all the parameters necessary for processing of 
instrument data. The processing context is made up of two parts, the current instrument 
and the current parameters. The current instrument defines the instrument used for 
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gathering the raw data. See instrument context for details. The current parameters 
defines all the processing variables for level 1 to level 4 data processing. See 
parameters context for details. 

5.1.1 Current Instrument 
Displays the currently loaded instrument context. All instrument configuration information 
is loaded and ready for processing. See instrument context for details. 

5.1.1.1 New 
Starts the process for creating a new instrument context. The user is asked to supply the 
location of the calibration file(s) or sip file(s) for the instrument, which are then used to 
create the instrument context. Note: All calibration file(s) (*.cal) or sip file(s) (*.sip)  
for the instrument context must remain in the same directory as the instrument 
context (*.cfs) file. 

5.1.1.2 Import 
Allows the user to import an existing instrument context file (*.cfs) for use in a new 
instrument context. 

5.1.1.3 Edit 
This option loads the current instrument context into the instrument context utility for 
editing. The user can choose to save the file under the existing instrument context name 
(‘Save’) or create a new instrument context (‘Save As’). 

5.1.1.4 Delete 
Permanently deletes the current instrument context. The context file (*.cfs) associated 
with the instrument context is not deleted. 

5.1.2 Current Parameters 
Displays the currently loaded parameters context. All processing parameters are loaded 
and ready for processing. See parameters context for details. 

5.1.2.1 New 
Starts the process for creating a new processing parameters context. The processing 
parameters utility will display with default values automatically loaded. 

5.1.2.2 Import 
Allows the user to import an existing parameters file (*.mat) for use in a new processing 
parameters context. 



 
ProSoft 7.7 User Manual  SAT-DN-00228-K 

15. Appendix D: Profiler/Reference 
Data Deglitching Function 

05/08/2017 01:20:47 PM 

 Page 16 of 75 

 

Copyright © 2017, Sea-Bird Scientific. All rights reserved. 
 

16 
 

5.1.2.3 Edit 
This option loads the current processing parameters into the processing parameters 
utility for editing. The user can choose to save the file under the existing processing 
parameters context name (‘Save’) or create a new parameters context (‘Save As’). 

5.1.2.4 Delete 
Permanently deletes the loaded processing parameters context. The original parameters 
file (*.mat) associated with the processing parameters context is also deleted. 

5.2 Multi-Level Processing 
Multi-level processing enables the user to process raw data up to level 2s, level 3a or 
level 4. All intermediate processing levels are automatically processed with 
accompanying files (*.HDF) being produced. To use this feature select the command 
button according to the ending processing level as desired. ProSoft will prompt the user 
to select the directory and choose file(s) (*.raw) of raw data. 

5.3 Single Level Processing 
Single level processing enables the user to process data over a single level. For 
example from level 1a to level 1b. To use this feature select the command button 
according to the starting processing level and ending processing level as desired. 
ProSoft will prompt the user to select the directory and choose file(s) (*.HDF or *.raw) for 
the starting processing level. 

5.4 File Menu 

5.4.1 Options 
Select this option to specify the ProSoft options for Data Files. 

The “Dynamic File Structure” option enables/disables the use of a separate folder for 
each processing level for the writing its output data file(s). 

The “Enable Raw File Parsing” option enables/disables the splitting of each selected raw 
data file into sections that can be processed separately. 

The “Raw File Parsing Size (Mb)” option allows the user to select the size of each 
section when the option to split raw data files is enabled. 

5.4.2 Exit 
Select this option to exit the current ProSoft session. The last loaded instrument context 
and processing parameters context will be automatically loaded next time ProSoft is 
started. 
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5.5 Tools Menu 

5.5.1 MAT Data Extractor 
This utility converts HDF files into a MATAB data structure. This structure is then saved 
into MATAB binary format (*.mat) which can be directly imported into the MATAB 
workspace for further analysis and manipulation. See mat data extraction for details. 

5.5.2 HDF Viewer 
Select this option to access the HDF viewer utility which allows the user to view HDF 
files in 2-D or 3-D graphical format. The utility will open in the empty state. Simply select 
‘File -> Open’ to load HDF files for viewing. See HDF data viewer for details. 

5.6 Ascii Menu 

5.6.1 General Data Product 
This utility converts HDF files to tab separated ASCII file format. ProSoft will prompt the 
user to select the directory and choose file(s) (*.HDF) for ASCII data extraction. HDF 
files at any level can be extracted. See ASCII data extraction for details. 

5.7 Help Menu 

5.7.1 Definitions 
Select this option to view a list of definitions of ProSoft terms. See appendix A term 
definitions for list of definitions. 

5.7.2 About 
Select this option to view the history of revisions for ProSoft versions. This lists the latest 
changes made to ProSoft. See revisions for details. 
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6. Instrument Context 

Instrument Context is defined as the current 
instrument package (i.e. profiler + reference) and 
deployment parameters loaded into ProSoft that will 

be used for data processing. The instrument context file (*.cfs) used to describe this 
instrument deployment is loaded into memory ready to be recalled when necessary for 
processing. 

The user can switch between instrument packages easily by clicking on the drop down 
box and selecting from the list of instrument contexts that have been defined by the user. 
When an instrument is chosen the instrument context file associated with the instrument 
package is automatically loaded and ProSoft is ready to process data. 

6.1 Deployment Parameters 
The Instrument Context deployment parameters are used to specify required information 
related to the instrument's deployment when the raw data to be processed was acquired. 
These parameters are: “Water Medium” and “Pressure Tare”. 

Instrument Context Utility 
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Deployment Parameters 

Parameter Name Parameter Value Comments 
Pressure Tare In Water, On Deck Method used to obtain pressure 

tare for a profiler. 

Water Medium Sea water, Fresh water Water type in-situ. 

 

6.1.1 Water Medium 
The Water Medium parameter is used to specify the type of water the instrument was 
deployed in when the raw data to be processed was acquired. This parameter is 
required for the “ECO Series IOP” instrument type for calculating the total backscattering 
coefficient. 

6.1.2 Pressure Tare 
The Pressure Tare parameter is used to specify the method used to obtain the pressure 
tare measurement when a profiler instrument was deployed. The possible pressure tare 
methods are “On Deck” and “In Water”. In either case the pressure tare is performed just 
prior to deployment of a profiler. 

The “On Deck” method is performed with the profiler instrument held upright on deck in 
the vertical position. The “In Water” method is performed with the profiler instrument 
upright in the water with the top of the irradiance sensor at the surface of the water. 

Note: The “In Water” method is no longer recommended, better accuracy and ease 
of use can be achieved using the “On Deck” method. 

6.2 Available Calibration Files 
This is a list of all calibration files (*.cal and .tdf) located in the current directory or files 
associated with a sip file (*.sip). In the case of creating a new instrument context the 
current directory or sip file(s) are selected prior to displaying the instrument context 
utility. When editing or importing, the current directory is the directory that the instrument 
context file is located in. 

6.3 Loaded Calibration Files 
This is a list of all calibration files (*.cal and *.tdf) that are loaded in the instrument 
context. These are the calibration files which will be associated with the instrument 
context. These can be added or removed as needed. 

6.4 Calibration File Parameters 
The ‘Calibration File Parameters’ displays all current configuration information on the 
calibration file selected in the ‘Loaded Calibration Files’ selection box. See table 
‘Calibration File Settings’. 
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6.4.1 Sensors 
This is a list of optical sensors defined within the selected calibration file. 

6.4.2 Frame Tag 
Indicates the frame tag associated with the calibration file as it appears in the raw or 
level 1 telemetry data. 

6.4.3 Instrument Type 
Select the type of instrument represented by the calibration file. For a list of possible 
values see instrument context parameters and calibration file settings tables. 

6.4.4 Immersion Coefficient 
Select which calibration coefficients to use for processing depending on instrument  
immersion mode (i.e. Air or Water). 

6.4.5 Measurement Mode 
Select which mode of measurement to use for processing the calibration file and it’s 
associated raw data. 

6.4.6 Frame Type 
Select the frame type for the calibration file for dark current correction calculations. 

6.4.7 Instrument Context Parameters 
The instrument context parameters table indicates all the possible combinations of 
selectable configuration parameters based on the instrument type. 

6.4.8 Calibration File Settings 
The calibration files settings table indicates the instrument parameters settings based on 
calibration file prefix. The prefix is obtained from the first three letters of the calibration 
file name which is listed in ‘Loaded Calibration Files’ in the instrument context utility. 
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Instrument Context Parameters 

Instrument Type Immersion Coefficient 

 

Measurement Mode Frame Type 

Profiler Water FreeFall 

 

ShutterLight 

ShutterDark 

Anc 

LightAncCombined 

Reference Water 

Air 

Surface 

 

ShutterLight 

ShutterDark 

Anc 

LightAncCombined 

TACCS Water Chain 

 

LightAncCombined 

SAS Air VesselBorne 

AirBorne 

 

ShutterLight 

ShutterDark 

Anc 

LightAncCombined 

GPS Not Required Not Required Not Required 

ECO Series IOP Not Required FreeFall 

Surface 

Not Required 

 
Calibration File Settings 

Cal File 
Prefix 

Instrument Type Sensors Immersion 
Coefficients 

Measurement 
Mode 

Frame Type Notes 

BB2F ECO Series IOP Fluor Not Required [FreeFall Surface] Not Required Wetlabs 
Fluorometer 

DI4 Profiler/Reference [Ed Eu]/[Es Ev 
Ef] ** 

Water/Air FreeFall/Surface LightAncCombined 4 channel 
irradiance sensor 

DR4 Profiler/Reference [Lu Ld]/Ls Water/Air FreeFall/Surface LightAncCombined 4 channel 
radiance sensor 

DI7 Profiler/Reference [Ed Eu]/[Es Ev 
Ef] 

Water/Air FreeFall/Surface LightAncCombined 7 channel 
irradiance sensor 

DR7 Profiler/Reference [Lu Ld]/Ls Water/Air FreeFall/Surface LightAncCombined 7 channel 
radiance sensor 

HED Reference/SAS Es/Es Air/Air Surface/VesselBor
ne 

ShutterDark Hyperspectral 
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HLD Reference/SAS Ls/Lt Water/Air Surface/VesselBor
ne 

ShutterDark Hyperspectral 

HSE Reference/SAS Es/Es Air/Air Surface/VesselBor
ne 

ShutterLight Hyperspectral 

HSL Reference/SAS Ls/[Lt Li] Water/Air Surface/VesselBor
ne 

ShutterLight Hyperspectral 

HPE Profiler Ed Water FreeFall ShutterLight Hyperspectral 

HPL Profiler Lu Water FreeFall ShutterLight Hyperspectral 

HSD Reference Lu Water Surface ShutterDark Hyperspectral 
TSRB 

HST Reference Lu Water Surface ShutterLight Hyperspectral 
TSRB 

MPR* Profiler/Ancillary Lu Ed Eu 
Ld/Tilt Press T 

Water/[Water 
Air] 

FreeFall/[FreeFall 
Surface] 

LightAncCombined/
Anc 

Multispectral/ 

Ancillary 

MRF SAS Ls Lt Es Air VesselBorne LightAncCombined Multispectral 

MVD Reference Es Ls Ef Ev Air Surface LightAncCombined Multispectral 

OCP Profiler Lu Ed Eu Ld Water FreeFall LightAncCombined Multispectral 

PED Profiler Ed Water FreeFall ShutterDark Hyperspectral 

PLD Profiler Lu Water FreeFall ShutterDark Hyperspectral 

PRO Profiler Lu Ed Eu Ld Water FreeFall LightAncCombined Multispectral 

REF Reference Es Ls Ef Ev Air Surface LightAncCombined Multispectral 

TAC Taccs Lu Ed Es Water Chain LightAncCombined Multispectral 

SATNAV SAS Ancillary Air VesselBorne Anc Solar Tracker 

* MPR calibration files can be either a profiler or ancillary instrument. It’s most common 
use is as an ancillary instrument which can be determined by it’s lack of optical sensors 
(i.e. Lu Ed). When used as an ancillary instrument it’s measurement mode can be either 
FreeFall if attached with a profiler or Surface if attached with a reference. The frame type 
when used as ancillary should be Anc. 

** [ ] Brackets indicate mutually exclusive sensors. For example [Lu Ed] indicates only Lu 
or Ed sensor will be present but never both. 

6.5 Sensor Parameters 
The ‘sensor parameters’ displays all current configuration information on the sensor 
selected in the ‘Sensors’ selection box. 

6.5.1 Channels 
All the channels available from the selected optical sensor are displayed here. For 
optical sensors this will be a list of all sensor wavelengths. 
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6.5.2 Configuring Sensor Distances 
The sensor head distances are needed in order to compensate for the fact that the 
pressure sensor is not located at the same position as the sensor heads. In order to 
calculate the pressure at the sensor head this geometrical difference must be known and 
included in the instrument context file (all units must be in meters). 

When configuring a profiler it is assumed that the Ed sensor head is located at the ‘top’ 
of the instrument. In other words it is the last sensor to be immersed when profiling. For 
the profiler it is important to include the distance between each sensor head and the Ed 
sensor head (top of the instrument). This value is entered into ‘Distance to Surface’. The 
‘Distance to Pressure’ value is only required for the Ed sensor when taking the pressure 
tare on deck as outlined below in ‘Distance to Pressure’. In all other cases leave this 
value at zero. 

� SAS instruments do not need to specify any distances. 

� ECO Series IOP sensors should always specify the distance to surface. 

The following diagram shows how the sensor distances to surface and pressure are to 
be measured for the following instruments: MicroProfiler, HyperProfiler II. 

 
 
Note: Please refer to the illustrations provided in the appendix for the most 
common instrument configurations. Instrument configurations and distances may 
not be the same for your instrument. Always measure distances when creating an 
instrument context file for your instrument. 

6.5.2.1 Distance to Surface 
This is the physical distance between the sensor head and the top of the instrument for 
profilers, and the distance between the sensor head and the surface of the water, if 
immersed, for references. This positive value should always be specified for sensors 
located below the top of the instrument (i.e. Lu sensor, ECO Series IOP sensor, Ls 
sensor). 

6.5.2.2 Distance to Pressure 
This positive value is used only for profiler sensors to indicate the physical distance 
between the sensor head and the pressure reference line on the profiler and should only 
be given values when the On Deck method was used to obtain the pressure tare. 

 

 
Pressure Tare Method 
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6.5.2.3 In Water Pressure Tare Method 
Pressure tare is taken when the Ed sensor is located at the surface of the water.  
For this method the pressure tare then becomes a combination of the atmospheric 
pressure and the pressure of the water column from the surface (Ed head)  to the 
pressure sensor reference line. The pressure value at Ed is calculated by subtracting the 
pressure tare value from the measured pressure values. The pressure value at Lu is 
calculated by subtracting the pressure tare value from the measured pressure values, as 
calculated for Ed, and then adding the distance between the Lu sensor head and the Ed 
sensor head. (i.e. Lu “Distance to Surface”) 

When using this pressure tare mode it is very important that you do not specify a 
value other then zero for ‘Distance to Pressure’ for any sensors. 
Pressure Ed = Measured Pressure – Pressure Tare 

Pressure Lu = Measured Pressure – Pressure Tare + Distance to Surface (Lu) 

 

Example sensor distance values for “In Water” Method: 
 

MicroPro (7 channel) Ed Lu 
Distance To Surface 0.0 0.101346 

Distance To Pressure 0.0 0.0 

 
MicroPro (14 channel) Ed Lu 
Distance To Surface 0.0 0.28575 

Distance To Pressure 0.0 0.0 

 
HyperPro II Ed Lu 

Distance To Surface 0.0 0.315 
Distance To Pressure 0.0 0.0 

 
HyperPro II (surface mode) Ed Lu 

Distance To Surface 0.200 0.200 
Distance To Pressure 0.0 0.0 

 
STOR-X Plus (2 x HyperPro) Ed Lu 

Distance To Surface 0.0 0.021 
Distance To Pressure 0.0 0.0 
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6.5.2.4 On Deck Pressure Tare Method 
Pressure tare is taken when the profiler is located on deck. In this case the pressure 
tare is equal to the atmospheric pressure. The pressure tare value is then added to the 
distance from the Ed head to the pressure sensor reference line. For this reason it is 
crucial to specify a ‘Distance to Pressure’ for the Ed sensor in the instrument context 
utility. 

Pressure Tare = Pressure Tare (Atmospheric Pressure) + Distance to Pressure (Ed) 

Pressure Ed = Measured Pressure – Pressure Tare 

Pressure Lu = Measured Pressure – Pressure Tare + Distance to Surface (Lu) 

 

Example sensor distance values for “On Deck” Method: 
 

MicroPro (7 channel) Ed Lu 
Distance To Surface 0.0 0.100 

Distance To Pressure 0.697 0.0 

 
MicroPro (14 channel) Ed Lu 
Distance To Surface 0.0 0.287 

Distance To Pressure 0.796 0.0 

 
HyperPro II Ed Lu 

Distance To Surface 0.0 0.316 
Distance To Pressure 0.786 0.0 

 
HyperPro II (surface mode) Eu (not recommended) Lu 

Distance To Surface 0.200 0.200 
Distance To Pressure 0.470 0.0 

 
STOR-X Plus (2 x HyperPro) Ed Lu 

Distance To Surface 0.0 0.021 
Distance To Pressure 0.079 0.0 

6.6 Creating a New Instrument Context 
When using ProSoft for the first time a warning message is given stating that no 
instrument context has been defined. To create a new instrument context use the 
following steps: 
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1. Click on ‘New’ in the ProSoft main menu. 

2. ProSoft will ask the user to point to a directory containing all the calibration files 
(*.cal) or sip files (*.sip). Note: The calibration files and instrument context 
file *.cfs should always remain together in the same directory. 

3. The instrument context utility will then display showing a list of all available 
calibration (*.cal) and tdf files (*.tdf) located in the directory selected in step 2. 

4. Highlight all the calibration files in ‘Available Calibration Files’ needed for the 
instrument context and click on add ‘>>’ to load the calibration files. For sip files 
this step is not necessary as the calibration files are automatically loaded. 

5. Configure all calibration file and sensor parameters as necessary and click on 
‘Save As’. 

6. The user is then prompted to enter an instrument context name. Once entered 
click on ‘Ok’. 

7. A dialogue box will then display confirming that the instrument context has been 
successfully created. Click on ‘Ok’ and ProSoft will load the instrument context 
just created. 

Whenever the user exits the program, ProSoft remembers the last instrument context 
that was loaded and automatically reloads that context when starting ProSoft. 

6.7 Configuring GPS 
To include GPS data in processing, several *.tdf and *.sip files have been included in the 
ProSoft installation directory. Simply copy these files into the same directory as the *cal 
or *.sip files being used for the instrument processing. When the instrument calibration 
files are bundled into *.sip files then use the gps.sip file exclusively, or if using *.cal files 
for the instrument then use any of the *.tdf GPS files. More than one type of GPS *.tdf 
file may be included in the ‘Loaded Calibration Files’ column. Sensor dimensions are not 
required for GPS. 

6.8 Instrument Context Examples 

6.8.1 Hyperspectral Profiler/Reference (HyperPro) 
The hyperspectral profiler/reference configuration is very common and usually contains 
a large number of calibration files (*.cal) and some tdf files (*.tdf). When working with 
hyperspectral instruments each optical sensor has two calibration files, one for 
shutterlight and the other for shutterdark frames. 

 
Calibration File Instrument Type Immersion 

Coefficient 
Measurement 
Mode 

Frame Type 

Hed117g.cal Reference (Es) Air Surface ShutterDark 

Hpe116h.cal Profiler (Ed) Water FreeFall ShutterLight 

Hpl118h.cal Profiler (Lu) Water FreeFall ShutterLight 

Hse117g.cal Reference (Es) Air Surface ShutterLight 
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Mpr012b.cal* Profiler (Anc) Water FreeFall Anc 

Ped116h.cal Profiler (Ed) Water FreeFall ShutterDark 

Pld118h.cal Profiler (Lu) Water FreeFall ShutterDark 

Bb2f-054.tdf ECO Series IOP Not Required FreeFall Not Required 

Gprmc.tdf Gps Not Required Not Required Not Required 

* The Mpr012b.cal file is an ancillary sensor attached to the profiler and is therefore given Profiler as 
instrument type and FreeFall as measurement mode. The FrameType is set as Anc to distinguish it from an 
optical sensor. 

6.8.2 Hyperspectral Profiler Acting as Reference (Buoy Mode) 
It is possible to add a floatation collar to the profiler sensors to have it remain at the 
surface collecting data and acting in buoy mode. Using the same calibration files when 
used as a profiler, each calibration file is set to Reference as instrument type. 

It is important to note that if an Ed sensor is present and functioning as a reference 
instrument then it will be re-labeled as an Es sensor at level 2s data processing. 
Therefore it is important to not include the Ed calibration files. There must only be one 
source of Es sensor data, so the user should choose to use the Es sensor and exclude 
the calibration files for the Ed sensor by removing them from the ‘Loaded Calibration 
Files’. 

In the same way as above if an Lu sensor is present and functioning as a reference 
instrument then it will be re-labeled as an Ls sensor at level 2s data processing. There 
must only be one source of Ls sensor data, so the user must choose to use either the Lu 
or Ls sensor and exclude the calibration files for the one not in use. 

 
Calibration File Instrument Type Immersion 

Coefficient 
Measurement 
Mode 

Frame Type 

Hse117g.cal Reference (Es) Air Surface ShutterLight 

Hpl118h.cal Reference (Lu) Water Surface ShutterLight 

Mpr012b.cal Reference (Anc) Air Surface Anc 

Hed117g.cal Reference (Es) Air Surface ShutterDark 

Pld118h.cal Reference (Lu) Water Surface ShutterDark 

6.8.3 Multispectral Profiler/Reference (MicroPro) 
Non-hyperspectral optical sensors usually use a LightAncCombined frame type. In many 
cases one calibration file will contain more than one optical sensor. 

 
Calibration File Instrument Type Immersion 

Coefficient 
Measurement 
Mode 

Frame Type 

DI7106a.cal Reference (Es) Air Surface LightAncCombined 

DI7112a.cal Profiler (Ed) Water FreeFall LightAncCombined 

DI7113a.cal Profiler (Ed) Water FreeFall LightAncCombined 
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DR7112a.cal Profiler (Lu) Water FreeFall LightAncCombined 

DR7113a.cal Profiler (Lu) Water FreeFall LightAncCombined 

Mpr049a.cal Profiler (Anc) Water FreeFall Anc 
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7. Parameters Context 

Processing Parameters Utility 
Near the top of the main menu is a section labeled ‘Current Parameters’. Parameters 
context is defined as the parameters that are loaded into memory to be used for data 
processing. For example they determine what type of dark correction to apply or how 
many data points to use when averaging. 

The user can easily switch between parameters contexts by clicking on the drop down 
box and selecting from the list of parameters contexts that have been defined by the 
user. When a parameters context is chosen the parameters file associated with the 
parameters context is automatically loaded and ready to process data. 

A detailed listing of all the processing parameters are given in the tables below. 
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Dark Correction Parameters 

Parameter Name Parameter Values Comments 
Auto Dark Correction CAL 

BIN 

SHUTTER 

Darks from cal file 

Darks from profile 

Darks from shutter frames 

Dark Bins Positive Integer Number of data points that are used to 
obtain bin darks from profile. Thus Dark 
Bins is used only if Auto Dark Correction 
is set to BIN. 

Shutter Dark Deglitch ON 

OFF 

ON – First difference filter will be 
supplied to deglitch shutter dark frames 
of optical data. 

Profile Editing Parameters 

Parameter Name Parameter Values Comments 
Profile Edit ON 

OFF 

Toggles profile edit mode on or off. 

Auto Edit ON 

OFF 

Automated profiler data editing using tilts 
or falling velocity when Profile Edit is ON. 

ON – automatic editing 

OFF – interactive editing 

Low Velocity Positive integer If profile edit and auto edit are turned 
ON, low velocity will be used for 
automatic editing only if tilt sensor is 
missing. 

High Tilt Positive integer If profile edit and auto edit are turned 
ON, high tilt will be used for automatic 
profile editing. 

Data Filtering Parameters 

Parameter Name Parameter Values Comments 
Deglitch Profiler Data ON 

OFF 

If ON, profiler data is deglitched using the 
value of Profiler Noise Threshold. 
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Profiler Noise 
Threshold 

Positive Integer Adjusts the sensitivity of profiler data 
deglitching. 

Upper Depth Level Positive Integer Sets shallow depth level below which 
profiler data is deglitched. 

Lower Depth Level Positive Integer Sets deep depth value above which 
profiler data is deglitched. 

Deglitch Reference 
Data 

ON 

OFF 

If ON, reference data is deglitched using 
the value of Reference Noise Threshold. 

Reference Noise 
Threshold 

Positive Integer Adjusts the sensitivity of reference data 
deglitching. 

Data Interpolation Parameters 
Parameter Name Parameter Value Comments 

Depth Resolution 0.01m, 0.02m, 0.05m 
or 0.10m 

Controls the depth resolution used for 
data integration at level 2s. 

Level 3a Averaging Parameters 
Parameter Name Parameter Value Comments 

Bin Interval The resolution based 
interval value ranges: 
0.01m:  0.01m – 2.0m 
0.02m:  0.02m – 2.0m 
0.05m:  0.05m – 5.0m 
0.10m:  0.10m – 10.0m 

Controls the depth interval which is 
the center point for profiler averaging.   
The range of possible values is 
determined by the selected Depth 
Resolution. 

Bin Width The resolution based 
width value ranges: 
0.01m:  0.0m – 2.0m 
0.02m:  0.0m – 2.0m 
0.05m:  0.0m – 5.0m 
0.10m:  0.0m – 10.0m 

Controls the number of data points 
used in averaging based on depth. 
The range of possible values is 
determined by the selected Depth 
Resolution. 

Time Interval Any 1 second interval 
(i.e. 1, 2, 10, 17 etc.) 

Controls the time interval which is the 
center point for reference/SAS 
averaging. 

Time Width Any 1 second interval (i.e. 1, 2, 
10, 17 etc.) 

Controls the number of data points 
used in averaging based on time. 

Wavelength 
Interpolation 

OFF, 1, 2, 5, 10 Controls the interpolation interval 
when interpolating onto a constant 
wavelength. Only applicable for 
hyperspectral instruments. 

Level 4 Settings 
Parameter Name Parameter Value Comments 

Integration Points Must be an odd 
number 

Number of data points used to 
calculate K values. 
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(i.e. 1, 3, 5, 7 etc.) 
Reflection Albedo Default value of 0.043 Fresnel reflection albedo for 

irradiance from sun and sky. 
Reflectance Index Default value of 0.021 Fresnel reflectance index of 

seawater. 
Refractive Index Default value of 1.345 Fresnel refractive index of seawater. 
ET Solar Irradiance Neckel & Labs, 

Thuillier 
Extra-terrestrial solar irradiance 
spectrum. 
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8. ASCII Data Extraction 
The ASCII data extractor utility allows the user to convert any ProSoft HDF file into tab 
separated ASCII file format. This format can be used to import data into an excel 
spreadsheet or other program that can use ASCII tab delimited files. 

To extract HDF files use the following procedure: 

1. From the main menu click on menu ‘Tools -> General Data Product’. 

2. A folder selection dialogue will appear from which the user selects a folder with 
the HDF files to be extracted. 

3. Next a list of all HDF files in the directory selected in step 2 will be displayed. The 
user can select as many HDF files as desired. 

4. Click on ‘Ok’ to start the file extraction process. 

All the extracted ASCII files will be place in a directory called ‘Ascii Files’. This directory 
will be located in the same directory as the HDF files selected in step 2. If the ‘Ascii Files’ 
directory cannot be created then the ASCII files will be located in the same directory as 
the HDF files selected in steps 2 and 3. 

ProSoft will write up to a maximum of 256 columns per row after which the data will wrap 
to the next section of rows. This ensures the ASCII file can be imported to excel without 
loss of data. 

Included in the ASCII file is the HDF file header which includes metadata important for 
data interpretation. 
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9. MAT Data Extraction 
The MAT data extractor utility allows the user to convert any ProSoft HDF file into a 
MATAB structure which is saved into a MATAB binary file (*.mat). This format can be 
used to import the HDF data structure directly into a MATAB workspace for further 
analysis and manipulation. 

To extract HDF files use the following procedure: 

1. From the main menu click on menu ‘Tools -> MAT Data Extractor’. 

2. A folder selection dialogue will appear from which the user selects a folder with 
the HDF files to be extracted. 

3. Next a list of all HDF files in the directory selected in step 2 will be displayed. The 
user can select as many HDF files as desired. 

4. Click on ‘Ok’ to start the file extraction process. 

All the extracted .mat files will be place in a directory called ‘Mat Files’. This directory will 
be located in the same directory as the HDF files selected in step 2. A Mat file has the 
same file name as it’s corresponding HDF file but with the .mat file extension. 

To import the HDF data structure into the MATAB workspace use the ‘load’ command or 
simply double click on the *.mat file when viewed in the ‘Current Directory’. The structure 
called ‘hdfdata’ will load into the MATAB workspace and is now available for analysis. 
The field names in the hdfdata structure are representative of the vdata table names in 
the HDF file. 
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10. HDF Data Viewer 
The HDF viewer enables the user to view ProSoft data in graphical format. To use the 
HDF viewer simply apply the following steps: 

1. To start, from the main menu, select menu ‘Tools -> HDF Viewer’. 

2. The HDF Viewer utility will open but with no HDF files loaded. To load files select 
menu ‘File -> Open’. 

3. A folder selection dialogue box appears from which the user selects the folder 
containing HDF files for viewing. 

4. Next a list of all HDF files in the directory selected in step 2 will be displayed. The 
user can select as many HDF files as desired then click on ‘Ok’. 

The HDF viewer controls are outlined as follows: 

10.1 File Menu 

10.1.1 Open 
Loads a new set of HDF files for viewing. 

10.1.2 Save As 
Save the graph to a file using the png graphic format. 

10.1.3 Print 
Prints the graph currently displayed in the graph axes. 

10.1.4 Exit 
Exits the HDF viewer utility and returns to the ProSoft main menu. 

10.2 Attributes Menu 

10.2.1 HDF File 
Select to view the HDF file attributes or metadata applicable to the entire HDF file such 
as cruise id, date, processing level etc. 

10.2.2 Sensor Group 
Select to view the attributes or metadata applicable to the selected sensor group such as 
instrument type, media, measurement mode etc. 

10.2.3 Sensor Data Table 
Select to view the attributes or metadata applicable to the selected sensor data table 
such as units for each sensor field. 
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10.3 HDF File Selected 
This drop down box displays the current HDF file being viewed. All HDF files that were 
selected for viewing are listed in this drop down box. To switch files simply click on the 
drop down box and choose an HDF file. 

10.4 Sensor Group 
This control lists all the sensor groupings for the selected HDF file. Each sensor group 
corresponds to an instrument calibration file. Common sensor groups are Profiler, 
Reference, SAS, ECO Series IOP etc. 

10.5 Independent/Dependent Variables 
These controls list all the independent and dependent variables available for the chosen 
sensor group. 

10.6 Graph Type 
Use the graph type buttons to select which type of graph is required. Note: Certain 
sensor data tables are not available for viewing in 3-D. In this case the option for 
selecting 3-D will be grayed out and unavailable for selection. 

10.7 Graphing Options 

10.7.1 Overlay 
When this option is selected any subsequent graphing will overlay each other. This 
useful for comparing data from different dependent variables. 

10.7.2 Grid 
When this option is selected a grid overlay will be drawn on the graph. This option is only 
available for 2-D graphs as it is always on by default for 3-D graphs. 

10.7.3 Rotate 
When this option is selected the user is able to hold down the left mouse button while 
over the graph and move the mouse to rotate the graph view. This option is only 
available for 3-D graphs. 

10.7.4 Zoom 
When this option is selected the user is able to zoom in or out of the graph. To zoom in 
left click the mouse button while over the graph and to zoom out right click the mouse 
button. To select a portion of the graph to zoom, left click and hold the mouse button 
while over the graph and drag the area selection box. When completed release the 
mouse button and the graph will zoom on the area selected. This option is only available 
for 2-D graphs. 
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10.7.5 Graph 
When all the desired independent/dependent ranges are selected click on ‘Graph’ to 
draw the graph in the axes. When zooming or rotating a graph simply click on ‘Graph’ to 
return the graph to it’s original view. 

10.7.6 Legend 
In 2-D graphing mode a legend is displayed on the axes showing the field color-coding 
scheme for the graph. The legend can be moved by left clicking and dragging the legend 
to a different location on the axes. Make sure the zoom option is turned off when moving 
the legend. In 3-D graphing mode a color contour legend is displayed outside the axes, 
relating color with z-axis value for easier viewing. 
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11. Data Processing Equations 
Processing Levels Supported 

 Profiler Reference SAS TSRB TACCS 

1a X X X X X 

1b X X X X X 

2 X X X X X 

2s X X X X  

3a X X X X  

4 X X  X  

Note: Includes both multispectral and hyperspectral instruments 

This section is intended to give an overview of the main steps of radiometric data L(z, l) 
processing carried out by ProSoft.  It is assumed that the radiometric data has been 
collected using an optical instrument with a raw data format that is in compliance with 
Satlantic Log File Standard (SLFS). 

ProSoft processing is segmented into 4 main levels: 

Level 1 - Raw binary data file from an instrument. File extension is RAW. 

Level 1a - Binary data is extracted from raw data under the control of the instrument 
(calibration and/or telemetry definition) files. Extracted information is grouped along with 
its calibration information and is placed into Level 1a HDF files. File nametag is _L1a. 

Level 1b - Level1b data is calibrated. If selected, CAL, BIN or NULL dark correction is 
applied. File nametag is _L1b. 

Level 2 - Includes Level 1b data, which is further modified per request (i.e. depending on 
settings of processing parameters and on instrument context). File nametag is _L2. 

1. Reference and dark data deglitching is applied. 

2. If selected, SHUTTER dark correction is applied. 

3. If a profiler instrument exists, profile editing is performed. 

Level 2s – Level 2 data is interpolated onto a common co-ordinates vector, which is 
either depth (Profiler) or time (Reference only or SAS). File nametag is _L2s. 

Level 3a – Includes averaging of Level 2s data as defined by the processing 
parameters. File nametag is _L3a. 

Level 4 – Includes higher level data products (users choice) calculated from level 3a 
data. This includes products such as normalized water leaving radiances, reflectance 
profiles, photosynthetically available radiation etc. File nametag is _L4. 
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11.1 Level 1a - Level 1b Data Processing 

11.1.1  Application of Calibration Data to Level 1a Files 

11.1.1.1  Optical Data Calibration 
Standard optical sensor data formats are processed differently based on the capabilities 
of the various types of acquisition systems.  These are referred to in Satlantic Instrument 
Files Standard (SIFS) as OPTIC1 (high-resolution gain switching 24 bit systems), 
OPTIC2 (standard 12, 16, 24 or 32 bit systems), and OPTIC3 (hyperspectral systems 
with adaptive integration).  Application of the calibration data to all optical and ancillary 
sensors is carried out in accordance to the procedures detailed in SIFS for conversion 
from binary (or ASCII) digital counts into engineering units.  In general, optical data is 
converted into engineering units in accordance to the calibration equation: 

Equation 1 General Calibration Equation 
( ) ( ) ( )( ) ( ) ( )lllll icaLzLzL CalDarkDattDatCountsLighLightDat ××-= ,,  

where a  is a calibration coefficient and ic is an immersion coefficient obtained from a 
calibration file.  To simplify notation, in the following dependence on wavelength (l ) will 

be omitted.  icaLCalDarkDat ××  is the dark current in engineering units that can be obtained 
from a calibration file or using one of the dark current correction (DCC) methods 
described below. 

ProSoft currently implements DCC other than calibration dark or shutter dark only in 
OPTIC1 (high resolution 24 bit systems) fitting mode (see SIFS for detailed explanation 
of the fitting modes).  Dark current can change under changing thermal conditions on 
these high-resolution systems.  Dark current correction has to be adjusted accordingly.  
ProSoft provides the different DCC methods that will be described in the following 
sections. 

It is important to note that DCC other than based on the calibration file (except 
hyperspectral) can only be used for the measurement frames obtained with gain switch 1 
or higher in OPTIC1 fitting mode (in gain switch 0, or low gain, the CAL darks are used).  
In OPTIC1 fitting mode, ProSoft first analyses the measured frames according to the 
gain switches and applies the DCC according to the Dark Current Correction scheme 
selected by the user.  In OPTIC2 fitting mode there are only two options available, CAL 
and NULL. 

11.1.1.2 CAL darks 
DCC method with calibration darks is given by the general calibration equation.  This is 
the default mode for both OPTIC1 and OPTIC2 data types. 

11.1.1.3 NULL darks 
NULL dark is a special mode in which no darks are subtracted during data calibration 
(note that in the fitting mode OPTIC1, cal darks will be still subtracted for the frames with 
gain switch 0). 
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Equation 2 NULL Dark 
( ) ( ) ( ) ( )llll icazLzL tDatCountsLighLightDat ××= ,,  

11.1.1.4 BIN darks 
If the profiler reaches a depth for which all the optical sensors reach their dark level, then 
the darks can be computed from the average of a number of samples at the bottom of 
the profile.  For each wavelength λ, the value of DCC is obtained from a layer where 

average minimum light values 
( )( )l,min zLLightDat are observed. 

Equation 3 BIN Dark 

( ) ( ) ( )
maxmin ,...,

,min,,

zzz

zLzLzL LightDatLightDatLightDat

=

-= lll

 

11.1.1.5 Dark Current Correction of hyperspectral (OPTIC3) Data 
Usually hyperspectral data is dark corrected with the values obtained from shutter darks 
to obtain the most accurate correction.  Shutter darks are continuously recorded during 
the measurements by occulting the input fiber with an optical shutter, typically after every 
five light samples.  Hyperspectral calibration and subsequent DCC is carried out in the 
following steps: 

1. Correct shutter dark counts obtained from a log file by dark offset (obtained as 
the difference between shutter darks and capped darks). 

Equation 4 Hyperspectral Dark 

OffsetCountsDarkDatCountsDarkDatCountsDark LLL -=  
2. Convert data counts into engineering units in accordance to the calibration 

equations. The calibration equations for optical hyperspectral data is: 

Equation 5 Hyperspectral Data Calibration 

( )

( )
2

1

2

1

it
iticaLLL

it
iticaLLL

CalDarkDatDatCountsDarkDarkDat

CalDarkDattDatCountsLighLightDat

××-=

××-=

 
where a  is the calibration coefficient, ic is an immersion coefficient, it1 is the integration 
time during calibration and it2 is the integration time during the measurement.  a, ic and 
it1 are taken from a calibration file,  it2 is obtained from the same log file as optical data. 

3. Deglitch dark data using a first difference filter (optional). 

4. Interpolate shutter darks as a function of measurement time to match the number 
of dark and light data measurements. 

5. Correct light data using shutter darks. 
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Equation 6 Hyperspectral Dark Correction 

DarkDatLightDat LLL -=  
Note: SAS Instrument 
GPS UTC time that was presented at Level 1a in HHMM (hours, minutes) format is 
recalculated into seconds from the start of the current day. GPS date that was presented 
at Level 1a in DDMMYY (day, month, year) format is recalculated into days since start of 
the current year. 

Note: Profiler 
If one wants to use other than shutter dark (can be applied only to hyperspectral profiler) 
correction (e.g. NULL) then AUTODARK settings should be changed for all profiler sensor 
groups respectively i.e. one should change AUTODARK from SHUTTER to NULL in the 
profiler sensor group that contains Lu as well as in the profiler group that contains Ed. One 
will get wrong results if one group will have AUTODARK set to SHUTTER, and the other 
group to NULL. However, one could use any of CAL, BIN, or NULL dark corrections in any 
of the groups. 

11.2 Level 1b – Level 2 Data Processing 
All optical data sensors are checked for wavelength sequence. The columns of optical 
data are organized from left to right as a function of the increasing wavelength. 

Optical data can be also deglitched if respective settings in processing parameters are 
set. As a rule the deglitching is not required. If selected, SHUTTER dark correction is 
applied. 

11.2.1 Dark Data Deglitching 
Optional deglitching module is applied to data to remove obvious glitches in dark data.  
First, a first difference operator is applied to the time series of N frames of optical data at 
each channel: 

Equation 7 Dark Data Deglitching 
( ) ( ) ( ) 1,...,1,1 -=-+= NiidLiLidL lll  

Second, the standard deviation is calculated for each channel: 

Equation 8 Standard Deviation 

( ) ( )( )å
-

=

-
-

=
1

1

2

2
1 N

i
dLidL

N
stdL lll

 

Third, any data which values are higher than 10 ( )lstdL  is blanked by a blanking 
constant Nan. 
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11.2.2 Data Deglitching 
This optional module can be toggled on/off using the processing parameters Deglitch 
Profiler Data and Deglitch Reference Data. For details on how it works see 
profiler/reference deglitching. 

11.2.3  Profiler Data Level 1b - Level 2 Processing 
Profiler data has a number of corrections and checks before the level 2 data files are 
created.  These include pressure tare (offset) correction, wavelength sequence check 
and profile editing that uses either tilt or velocity thresholds for quality control. 

11.2.3.1   Pressure Tare Correction 
Pressure sensors often have a small offset value that will change with atmospheric 
pressure.  The offset is removed by a pressure tare.  This value is stored in the header 
records by SatView when the data is collected.  The pressure tare is defined as the  
depth value in seawater that is measured when a profiler's Ed sensor is located just at 
the surface.  This value has to be later subtracted from the measured depth values of a 
profile.  If the profiler measurements were logged with SatView, the pressure tare value 
is automatically inserted into the file header.  If no information is obtained, pressure tare 
value is set to 0. 

11.2.3.2  Profile Editing 
Profiler measurements can be edited interactively or automatically removing any tilt 
contaminated records.  In manual mode, a plot is shown with profiler tilts (if available) 
and profiler velocity as a function of depth.  With the interactive graphical editor the user 
defines an upper zmin and lower depth zmax (we assume that z co-ordinate is directed 
downwards i.e. depth is zmin surface and zmax at the bottom of a profile).  Data above zmin 

or below zmax will be removed.  A tilt ( )zTilt threshold Tiltlimit (default is 5 degrees) usually 
is used for estimation of zmin and zmax.  In a case of missing tilt sensor, the freefall velocity 
of the profiler can be used (zero or negative velocity is assumed to be high tilt).  
Automated editor module determines zmin and zmax in 10% of the upper and lower part of 
profiler measurements.  The upper depth and the lower depth are defined as the first 
depth level (z) where the following conditions are met: 

( )

( ) profile  theoflayer  bottomfor )max()max(1.0)max(
profile  theoflayer  for top)max(1.0)min(

lim

zzzz
zzz

TiltzTilt it

£<-
<£

<

 
If a reference instrument is present, then the matching records in the reference data are 
also removed. 

11.2.3.3  Reference Instrument 
Reference data is checked before the level 2 data files are created.  These checks 
include wavelength sequence check and a spike deglitch.Level 2 – Level 2s Processing 
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11.2.4 Read Level 2 Data 
Data from the Level 2 HDF file is read and organized depending on the type of 
instrument (i.e. Satnet Hyperspectral Profiler/Reference). 

11.2.5 Calculate Master Co-ordinates 
 At level 3a processing, the averaging of data is done within intervals based on a system 
of co-ordinates. For systems with a profiler the co-ordinates are based on pressure 
(averaging in depth). For systems with a reference only or SAS the co-ordinates are 
based on time (averaging in time). 

11.2.5.1 Calculate Pressure Co-ordinates 
There exists in most instruments a difference in distance between sensors. For example 
in an SPMR profiler the distance between the Ed sensor at the top and the Lu sensor at 
the bottom is approximately 1.412 m. This presents a problem when defining a pressure 
co-ordinate system that is common to all sensors that make up the instrument. When 
processing optical data, the data closest to the surface is usually of greater importance 
than data at the deepest of the profile. Therefore it makes sense to choose the sensor 
nearest the surface which in all profiler cases is the Ed sensor. The pressure values for 
the Ed sensor, hereafter referred to as master pressure, are then used to derive the 
pressure co-ordinates. It should be noted that if no Ed sensor is present then the Lu 
sensor pressure must be used instead. 

The master pressure is then filtered to eliminate frames where pressure is not 
increasing. 

Equation 9 Pressure Filtering 
0)()1( £-+ ndepthndepth  

The pressure co-ordinates are created by rounding up the first master pressure value to 
the nearest 0.1 m then increasing the pressure by intervals equal to the depth resolution 
until reaching the highest (deepest) master pressure value which is rounded down to the 
nearest 0.1 m. For example: 

 

Master Pressure 
From Ed 

Pressure Co-
ordinates 

2.2657 2.3 

2.3727 2.4 

3.0684 2.5 

4.2028 2.6 

4.7808 etc. 

5.4015 6.3 

5.8510 6.4 



 
ProSoft 7.7 User Manual  SAT-DN-00228-K 

15. Appendix D: Profiler/Reference 
Data Deglitching Function 

05/08/2017 01:20:47 PM 

 Page 44 of 75 

 

Copyright © 2017, Sea-Bird Scientific. All rights reserved. 
 

44 
 

6.3326 6.5 

6.6323 6.6 

11.2.5.2 Calculate Time Co-ordinates 
Almost all reference instruments have an Es sensor which ProSoft uses to calculate the 
time co-ordinate system. In the case of SAS instruments, an Lt sensor is always present 
which is used to calculate the time co-ordinate system. There are three possible ways to 
calculate the time values, hereafter referred to as master time, for each frame of the Es 
or Lt sensor. They are listed below in order of precedence: 

1. If a timer sensor is part of the instrument, then this is the most accurate way to 
calculate the master time. The master time for the very first frame is taken as the 
first Timetag2 value if available else Time Stamp, the time at which logging data 
begins, is used. The timer values give the elapsed time for each frame since the 
time of the first frame which is used to calculate the absolute time for each frame. 
Note that timers are available in Satnet systems as well as Hyperspectral 
systems. 

2. If Timetag2 values were appended to the logged data then those values are used 
as the absolute time for each frame. 

3. The absolute time for the first frame is taken as the Time Stamp. The rate for the 
sensor is then used to calculate the elapsed time for each frame which in turn is 
used to calculate the absolute time for each frame. 

The time co-ordinates are created by taking the first master time value and then 
increasing it by an interval determined from the Es time data until reaching the last 
master time value. For SAS data the time interval is determined from the optical sensor 
operating at the fastest rate. 

 For example: (interval  = 0.100 sec) 

 

Master Time from Es Time Co-ordinates 

17:57:41.167 17:57:41.167 

17:57:41.333 17:57:41.267 

17:57:41.500 17:57:41.367 

17:57:41.667 17:57:41.467 

17:57:41.833 etc. 

17:57:42.000 17:57:42.167 

17:57:42.167 17:57:42.267 

17:57:42.333 17:57:42.367 

17:57:42.500 17:57:42.467 
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11.2.6 Coordinate Interpolation 
The data to be averaged is interpolated onto the master co-ordinates ensuring that all 
the data is mapped to a common co-ordinate system prior to averaging. The co-
ordinates are based on either pressure or time. The interpolation method used for both 
Profiler and Reference instruments is ‘linear’ and for SAS instruments ‘spline’ is used. 

11.2.7 Write Level 2s HDF File 
The interpolated data is written to the corresponding level 2s HDF file. 

 

 

 

 

 

 

11.3 Level 2s – Level 3a Processing 

 
 

 

 

 

 

 

 

 

 

 

 

11.3.1 Read Level 2s Data 
Data from the Level 2s HDF file is read and organized depending on the type of 
instrument (i.e. Satnet Hyperspectral Profiler/Reference). 

11.3.2 Wavelength Interpolation 
Profiler, Reference and SAS data can be interpolated onto a constant wavelength 
interval by setting the level 3 parameter Wavelength Interpolation to the desired interval. 
Wavelength interpolation should only be used for Hyperspectral instruments  because 
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Multispectral instruments have too few wavelength channels to provide an accurate 
interpolation. It is highly recommended to use wavelength interpolation for Hyperspectral 
profilers/references as it will help maximize the number of matching wavelengths for 
Level 4 processing. 

Note: Hyperspectral data that includes interpolated wavelength sensor fields is 
limited to the HDF4 maximum field limit of 512. If this limit is exceeded the 
wavelength sensor fields will be reduced so that the total number of sensor fields 
is 512. 

11.3.3 Natural Log Transform 
Optical sensor data (Lu, Es etc.) are natural log transformed to “straighten” the data prior 
to averaging. 

11.3.4 Average Data 
The data is then averaged based on the level 3 parameters Bin Interval and Bin Width 
for pressure co-ordinates and Time Interval and Time Width for time co-ordinates. The 
Bin Interval or Time Interval determine the points at which to average with the Bin Width 
or Time Width determining the number of data points to use for averaging. 

For example: BIN_INTERVAL = 0.5 m BIN_WIDTH = 0.3 m 

11.3.5 Write Level 3a HDF File 
The averaged data is written to the corresponding level 3a HDF file. 

11.4 Level 4 Data Processing 
When using the level 4 processing menu a dialog box allows the user to specify which 
level 4 products to include in the level 4 HDF file. Each option selected will be included 
as a separate sensor within the HDF file. The first two options, ‘Diffuse Attenuation 
Coefficient’ and ‘Propagate Optical Variables to Surface’ are sometimes needed to 
process other selections such as Water Leaving Radiance and will therefore be 
automatically selected when needed. 

Notes On Wavelength Differences: When processing calculations that involve data 
from two different sources (e.g. comparing Lu and Ed sensors) the wavelengths from the 
two sources will never be exact (e.g. Lu 489.8nm and Ed 490.1nm), unless wavelength 
interpolation was selected at level 3a. Therefore ProSoft uses a matching tolerance 
between wavelengths in order for the channels to be used in the calculation. For 
example if Lu is 489.8nm and the closest Ed channel is 490.1nm (490.1 – 489.8 < 
tolerance) these two channels can be used together in a calculation. In Level 4 data 
presentation the wavelength shown is the mean value between the two wavelengths 
(e.g. 489.95nm from the above example). Tolerances are set as follows, multispectral 2 
nm and hyperspectral 0.5 nm. 

11.4.1 Diffuse Attenuation Coefficient 
Overview: Under typical conditions for which incident lighting is provided by sun and sky, 
the various radiance and irradiance all decrease exponentially with depth, at least far 
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enough below the surface (and far enough above the bottom in shallow water) to be free 
of boundary effects. This effect can be generally expressed as: 

Equation 10 Diffuse Attenuation Coefficient 
 Ocean Optics Protocols for SeaWiFS eqn. 26 pg. 49 

( ) ( )
( )ò

=
-

-

z

d dzzk

dd eEzE 0

','

,0,
l

ll  
( )l,zEd - downwelling irradiance as a function of depth and wavelength. 

( )l,0-dE - surface value of downwelling irradiance as a function of wavelength. 

( )ò-
z

d dzzk

e 0

',' l

- effect of the diffuse attenuation coefficient as a function of depth 
and wavelength. 

The traditional method of k analysis (Smith and Baker 1984 and 1986) is to estimate k(z) 
as the local slope of measured ln(Ed(z)) in an interval of a few meters centered on depth 
zm. 

Equation 11 Traditional Method of K Analysis 
 Ocean Optics Protocols for SeaWiFS eqn. 31 pg. 50 

( )( ) ( )( ) ( ) ( )mmdd zkzzEzE --@ -0lnln  
The slope k and the intercept Ed(0-) are calculated using a least squares regression fit of 
the data over the number of regression points selected. 

p = polyfit( x, y, 1 )  MATLAB function. 

The degree of the resulting polynomial is one. 

For the shallowest and deepest depths of a profile there is not enough data points to 
meet the required number of points for regression. In this case the k value is calculated 
by selecting the required number of points nearest to the depth upon which the k value is 
centered. For example if 1m is the shallowest depth then the k value for 1m is based on 
level 3a data taken from 1m to 3m, if Integration Points = 5, and the k value for 2m is 
based on level 3a data taken from 1m to 4m. Therefore k values at the shallow and deep 
sections of the profile are unreliable and are not used for Level 4 data calculations. 

11.4.1.1 Integration Points 
Integration points is the processing parameter that determines the number of data points 
to use for regression analysis. Only odd number values can be used (e.g. 3,5, 7 etc.) in 
order for depth z to be centered on the level 3a depth interval (e.g. 3m, 5m, 7m etc.). 

In cases where there is only a reference instrument and no profiler, therefore no K_Lu, 
K_Ed or K_Eu, to propagate Ls to surface, then K is estimated from a time series of 
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upwelling radiance measured at a fixed depth below the surface. In this case ProSoft 
estimates the spectrum of K(λ) in three steps: 

1. Following the Austin Petzold (1981) model, K is estimated at the wavelengths 
443nm and 550nm. 

Equation 12 Austin Petzold 490nm 

( ) ( )
( ) 022.0
550
4430833.0490

491.1

+÷÷
ø

ö
çç
è

æ
=

-

Lu
LuK

 
Equation 13 Austin Petzold 520nm 

( ) ( )
( ) 044.0
550
4430663.0520

398.1

+÷÷
ø

ö
çç
è

æ
=

-

Lu
LuK

 
These K values are used in step 2 to obtain the concentrations of pigments C at 
490nm and 520nm. 

2. Morel’s (2001) empirical model for estimation of K is inverted to obtain the 
concentration of pigments (Chl a and Pheo): 

Equation 14 Morel 2001 

( ) ( ) ( )l

c
ll e

c

wKK
C

1

÷÷
ø

ö
çç
è

æ -
=

 
( )lwK - diffuse attenuation coefficient of water. Obtained from file 

MOR2001KW.FIT 

( )lc c - coefficient determined empirically. Obtained from file MOR2001CHI.FIT 

( )le - coefficient determined empirically. Obtained from file MOR2001EPS.FIT 

C is obtained as the average value of the two C’s calculated at 490nm and 
520nm and is used in step 3. 

3. The spectrum of K(λ) is obtained using Morel’s equation 9 (2001): 

Equation 15 Morel 2001 Equation 9 

( ) ( ) ( ) ( )llcll e
w CKKap +=  

To calculate Kap within 700-800nm, ProSoft uses the following steps: 

i. The values of Kw(λ) within 700-800nm are obtained from Smith and Baker (1981) 
MOR2001KW.FIT. 

ii. It is assumed that χ(λ) and e(λ) decrease linearly from the values given at χ(700) 
and e(700) to 0 and 800nm respectively. 
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iii. Using the above assumption and Kw within 700-800nm, K(λ) can be estimated at λ 
= 700-800nm interval. 

The K values calculated depend on the instrument configuration. Possible values are: 

 K_Ed 

 K_Lu 

 K_Eu 

 Kap_Ls – K is calculated using the Austin Petzold model 

11.4.2 Propagate Optical Variables to Surface 
The surface values of the profiler optical variables are obtained as the intercept of a 
least squares regression fit based on the shallowest depth centered on Zm. 

Equation 16 Surface Variables 
Ocean Optics Protocols for SeaWiFS eqn. 31 pg. 50 

( )( ) ( )( ) ( ) ( )mmdd zKzzEzE --@ -0lnln  
The calculated intercept is a product of the diffuse attenuation coefficient (Kd) 
calculation. As a result, if optical variables are propagated to the surface, the Kd profile 
for each optical variable (Lu, Ed and Eu) will be calculated and included with the level 4 
HDF file. In cases of shallow depths that do not meet the required number of  points for 
regression, the surface variable is calculated based on the intercept of the k slope from 
the first depth value that has the required number of points. For example in k analysis 
the surface optical variable Ed(0-) will be calculated on the intercept of the slope based 
on the k value at 3m and not at 1m or 2m. 

Possible values include: 

 Profiler: 

  Ed(0-) calculated from K_Ed 

  Lu(0-) calculated from K_Lu 

  Eu(0-) calculated from K_Eu 

 Reference: 

  Es(0-) if Es is measured above the surface then Es(0-) is calculated using: 

Equation 17 Es(0-) 

( ) ( )
a
l

+
=-

1
0 s

s
E

E
 

α – Fresnel reflection albedo for irradiance from sun and sky. Default 
value of 0.043 which can be changed as a level 4 parameter. 

Ls(0-) is calculated using one of the following (whichever one is available 
starting with the top): 
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K_Lu 

K_Ed 

K_Eu 

Kap_Ls – K is calculated using the Austin Petzold model 

  Example: 

Equation 18 Ls(0-) 
kzeLsLs ×- ×=),0( l  

 

If both Eu(0-) and Lu(0-) have been calculated then the Q factor is also calculated. 

Equation 19 Q(0-) 

 
( ) ( )

( )l
ll
,0
,0,0 -

-
- =

u

u

L
EQ

 

11.4.2.1 Reflection Albedo 
Processing parameter that sets the value for the Fresnel reflection albedo for irradiance 
from sun and sky. A default value of 0.043 is used and can be changed as a level 4 
processing parameter. 

11.4.3 Water Leaving Radiance 
Normalized water leaving radiance is estimated with the following equation: 

Equation 20 Normalized Water Leaving Radiance 
Ocean Optics Protocols eqn. 63 pg. 54 

( ) ( )
( )l
l

l
s

o
wwn E

F
LL =

 
Fo(λ) – the mean extraterrestrial solar irradiance (Neckel and Labs 1984) 

Es(λ) – downwelling spectral irradiance at z(0+) 

Lw(0+,λ) – upwelling radiance propagated through the surface z(0+) using: 

Equation 21 Water Leaving Radiance 

( ) ( ) ( )
( )lh
qlrll 2

,1,0,0
w

uw LL -
= -+

 
ρ(λ,θ) – Fresnel reflectance index of seawater. Default value of 0.021 for seawater 
which can be changed as a level 4 global variable. 

ηw(λ) – Fresnel refractive index of seawater. Default value of 1.345 for seawater 
which can be changed as a level 4 global variable. 
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Es(λ) from water leaving radiance is usually obtained from an above water reference, but 
in cases where no reference data is available Ed(0-,λ), measured by a profiler, is used. 
Ed is extrapolated through the surface using: 

Equation 22 Ed(0+) 

( ) ( ) ( )all -= -+ 1/,0,0 dd EE  
α – Fresnel reflection albedo for irradiance from sun and sky. Default value of 0.043 
is used which can be changed as a level 4 processing parameter. 

If Lu(0-,λ) from water leaving radiance is not available then Ls(0-,λ) is used instead. Ls(0-

,λ) is calculated when propagating variables to the surface. 

The values used for Fo(λ) (Neckel and Labs) can be found in the file Solar10.dat. 

11.4.3.1 Reflectance Index 
Fresnel reflective index for seawater. A default value of 0.021 is used and can be 
changed as a level 4 processing parameter. 

11.4.3.2 Refractive Index 
Fresnel refractive index for seawater. A default value of 1.345 is used and can be 
changed as a level 4 processing parameter. 

11.4.4 Surface Remote Sensing Reflectance 
Remote sensing reflectance RL(0+,λ) are calculated using: 

Equation 23 Surface Remote Sensing Reflectance 

( ) ( )
( )l

l
l

,0
,0

,0 +

+
+ =

d

W
L E

L
R

 
Ed(0+,λ) – denotes downwelling spectral irradiance measured just above the surface 
(Es) or extrapolated through the surface Ed(0+). For Es the median of the time 
series data is taken for each wavelength. 

Lw(0+,λ) – denotes upwelling spectral radiance propagated through the surface. 

The remote sensing reflectance calculations produce several possible combinations 
depending on the instrument configuration. Possible values include: 

 i. for Lu and Ed sensors Lu(0+,λ)/Ed(0+,λ) 

 ii. for Lu and Es sensors Lu(0+,λ)/Es(λ) 

 iii. for Ls and Es sensors Ls(0+,λ)/Es(λ) 

Ed is extrapolated through the surface using: 

Equation 24 Above Surface Ed(0+) 

( ) ( ) ( )all -= -+ 1/,0,0 dd EE  
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α – Fresnel reflection albedo for irradiance from sun and sky. A default value of 
0.043 is used and can be changed as a level 4 processing parameter. 

Lw is calculated using: 

Equation 25 Water Leaving Radiance 

( ) ( ) ( )
( )lh
qlrll 2

,1,0,0
w

uw LL -
= -+

 
ρ(λ,θ) - Fresnel reflectance index of seawater. Default value of 0.021 is used. 

ηw(λ) - Fresnel refractive index of seawater. Default value of 1.345 is used. 

11.4.5 Remote Sensing Reflectance Profile 
Remote sensing reflectance profile is calculated as the ratio of upwelling radiance to 
downwelling irradiance with changing depth. Only Lu is used for upwelling radiance and 
Ed for downwelling irradiance. 

Equation 26 Remote Sensing Reflectance Profile 
( )
( )l
l
,
,
zE
zL

RSR
d

u=
 

11.4.6 Surface Reflectance 
Surface reflectance is calculated as the ratio of upwelling irradiance just above the 
surface to downwelling irradiance just above the surface. 

Upwelling irradiance can be derived from several sources depending on the instrument 
configuration and include Eu(0+), Lu(0+) converted to Eu(0+), Ev(0+) and Ls(0+) converted 
to Ev(0+). 

Downwelling irradiance can be derived from several sources depending on instrument 
configuration and include Ed(0+) and Es. 

Equation 27 Surface Reflectance 

( )
( )l
l
,0_
,0_
+

+

=
IrradiancegDownwellin
IrradianceUpwellingRFL

 
The following sensor combinations are possible: 

i. Eu and Ed sensors: Eu and Ed are propagated above the surface using 

Equation 28 Above Surface Ed(0+) 

( ) ( ) ( )all -= -+ 1/,0,0 dd EE  
α – surface albedo (default = 0.043) 

RFL = Eu(0+,λ)/Ed(0+,λ) 

ii. Lu and Ed sensors: Lu is propagated above the surface and converted to Eu using: 
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Equation 29 Above Surface Eu(0+) 

( ) ( ) ( )
( )lh
qlrll 2

,1,05.4,0
w

uu LE -
×= -+

 
ρ – reflective index (default = 0.021) 

ηw – refractive index (default = 1.345) 

RFL = Eu(0+,λ)/Ed(0+,λ) 

iii. Lu and Es sensors: Lu is propagated above the surface and converted to Eu using 
equation Eu(0+,l). 

RFL = Eu(0+,λ)/Es(λ) 

iv. Ev and Es sensors : Ev is propagated above the surface using equation Ed(0+,l). 

RFL = Ev(0+,λ)/Es(λ) 

v. Ls and Es sensors: Ls is propagated above the surface and converted to Ev using 
equation Eu(0+,l). 

RFL = Ev(0+,λ)/Es(λ) 

11.4.7 Reflectance Profile 
The reflectance profile is calculated as the ratio of upwelling irradiance to downwelling 
irradiance. The most preferred method of calculation is to use upwelling irradiance Eu 
from the profiler and downwelling irradiance Ed, also from the profiler. 

Equation 30 Reflectance Profile 
( )
( )l
l
,
,
zE
zE

RFL
d

u=
 

11.4.8 Photosynthetically Available Radiation 
Photosynthetically available radiation is a measure of the number of photons available 
for photosynthesis by chlorophyll. Units of PAR are expressed as quanta/cm2s and is 
estimated using the following: 

Equation 31 Photosynthetically Available Radiation 

( )ò=
nm

nm
d dE

hc
PAR

700

400

lll

 
λ – wavelength 

h – Planck’s constant 6.625x10-34 Js 

c – speed of light 3x108 m/s 

Ed(λ) – downwelling spectral irradiance (µW/cm2 /nm) 
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Prior to integration Ed(λ) is interpolated onto a constant 1nm interval and subject to the 
following rules: 

 if λ1 > 400nm then Ed(400) = Ed(λ1) 

 if λn < 700nm then Ed(700) = Ed(λn) 

Included with the PAR data is the percentage of PAR for various depths. This ratio is 
calculated as: 

Equation 32 Percentage PAR 
( )
( )+=
0

%
PAR

zPARPAR
 

The attenuation coefficient of PAR (K_PAR(0-)) is also calculated near the surface using 
the same methods as described under the diffuse attenuation coefficient. This value is 
included in the data table attributes as K_PAR(0-). 

If reference Es data is available then PAR is calculated as: 

Equation 33 Reference Par 

( )ò=
nm

nm
s dE

hc
PAR

700

400

lll

 
The median value of PAR is then calculated and included in the vdata table attributes 
and called Reference PAR. 

11.4.9 Chlorophyll a Profile Estimates Morel 2001 Model 
The estimation of chlorophyll a concentration (µg/l) in profile is estimated for each depth 
level given from the level 3a HDF file. The method used is as follows: 

Equation 34 Morel 2001 Chlorophyll Model 

( ) ( )
( )

( )l

lc
ll e

C

WKK
C

1

÷÷
ø

ö
çç
è

æ -
=

 
χC, KW and e(λ) are taken from the Morel 2001 model. These values can be seen in the 
files MOR2001CHI.DAT, MOR2001KW.DAT and MOR2001EPS.DAT located in the 
ProSoft installation directory. 

The Morel 2001 model is derived from equation 9 pg. 10753 from: 

“Optical Modeling of the Upper Ocean in Relation to Its Biogenous Matter Content” 

Andre Morel 

Journal of Geophysical Research Volume 93 No. C9, pg. 10749-10768 

11.4.10  Chlorophyll a Surface Estimates SeaBAM OC2 Model 
Chlorophyll a concentration is estimated at the water surface using the remote sensing 
reflectance values calculated previously. 



 
ProSoft 7.7 User Manual  SAT-DN-00228-K 

15. Appendix D: Profiler/Reference 
Data Deglitching Function 

05/08/2017 01:20:47 PM 

 Page 55 of 75 

 

Copyright © 2017, Sea-Bird Scientific. All rights reserved. 
 

55 
 

Equation 35 Chlorophyll a Surface Estimate SeaBAM OC2 Model 
( ) 0929.010

32 0077.08358.02429.22974.0 -= -+- RRRC  
Equation 36 Calculation of R Coefficient 

( )nmRrs
nmRrsLogR 555

490
10=

 
The calculation of R coefficient uses the remote sensing reflectance values at 490nm 
and 555nm to calculate the value of R. Therefore several different calculations of 
Chlorophyll a are possible depending on how the remote sensing reflectance was 
calculated. The possible combinations are Lu(0+)/Es, Lu(0+)/Ed(0+) and Ls(0+)/Es. 

The value of R is then used in to calculate the chlorophyll a concentration (µg/l) at the 
surface. 

Equations for chlorophyll a surface estimate and calculation of R coefficient are derived 
from: 

“Ocean Color Chlorophyll Algorithms for SeaWiFS” 

O’Reilly et al. 

Journal of Geophysical Research, Volume 103, No. C11, pg. 24937-24953 

11.4.11  Chlorophyll a Surface Estimates Gordon 88 Model 
Chlorophyll a concentration is estimated at the water surface using the normalized water 
leaving radiance's calculated previously. 

Equation 37 Chlorophyll a Surface Estimate Gordon 88 Model 

( ) l
gCnmLwn

nmLwnC µ1560
44315.1

42.1
£=

-

 
Equation 38 Chlorophyll a Surface Estimate Gordon 88 Model 

( ) l
gCnmLwn

nmLwnC µ1560
50064.3

62.2
>=

-

 
The equations for Chlorophyll a surface estimate use normalized water leaving 
radiance's values at 443nm, 500nm and 560nm. Therefore several different calculations 
of chlorophyll a are possible depending on how the normalized water leaving radiance 
was calculated. The possible combinations are Lu(0+)/Ed(0+), Lu(0+)/Es and Ls(0+)/Es. 

Equations for Chlorophyll a surface estimates are taken from: 

“Ocean Color Remote Sensing Systems: Radiometric Requirements” 

H. Gordon 

Processing for Remote Sensing, pg. 151-167 

11.4.12  Estimation of Energy Fluxes 
Energy fluxes are estimated using the following equation: 
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Equation 39 Estimation of Energy Fluxes 

( )ò=
700

400

100 ll dEdF
 

ProSoft uses the MATAB trapezoidal numerical integration routine ‘trapz.m’ to perform 
the integration. Prior to integration, a minimum-maximum wavelength check is performed 
then the irradiance data is interpolated onto a constant 1nm interval. Since irradiance 
data is measured in units of μWcm-2nm-1, a scaling factor of 100 is used to convert from 
cm-2 to m-2. 

11.4.13 Backscattering Coefficients 
Backscattering values are derived from an ECO Series IOP instrument which contains a 
scattering meter to measure backscattering at 117 degrees within a volume of water. 

( )lb ,117! Values represent total volume scattering as measured by the instrument. To 
obtain the volume scattering of particles only, subtract the volume scattering of water, 

( )lb ,117!w from the total volume scattering: 

Equation 40 Volume Scattering of Particles 

( ) ( ) ( )lblblb r ,117,117,117 !!!
w-=  

( )lb ,117!w is obtained from (from Morel 1974): 

Equation 41 Volume Scattering of Water 

( ) ( ) ( ) ( ) ( )( ) 112432.4 1/1cos11037/3.01500/38.1, ---- +-++= srmSnmw ddqllqb  
d = 0.09 

S = Salinity obtained from water properties 

Particulate backscattering coefficients, ( )lbpb with units of m-1, can be determined 

through an estimation from the single measurement of ( )lb ,117!p using an X factor. 

This factor estimates bpb with an estimated uncertainty of 4%. 

Equation 42 Particulate Backscattering Coefficient 

( )!1172 pbp Xb bp=  
X = 1.1 (Boss, E, and S. Pegau, 2001. The relationship of scattering in an angle 
in the back direction to the backscattering coefficient, Applied Optics) 

Water backscattering coefficients, wb with units of m-1 can be determined by either of the 
following two equations: 
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Equation 43 Backscattering Coefficient Pure Water 

( ) ( ) 23.4500/0022533.0 -= nmbw ll  
Equation 44 Backscattering Coefficient Sea Water 

( ) ( ) 24.4500/0029308.0 -= nmbsw ll  

To compute the total backscattering coefficients, ( )lbb with units of m-1, the 

backscattering from pure water, ( )lbwb needs to be added to ( )lbpb : 

Equation 45 Total Backscattering Coefficient 
( ) ( ) ( )lll bwbpb bbb +=  
( )lbwb = ( ) 2/lwb or ( ) 2/lswb  
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12. Appendix A: Term Definitions 

12.1 File Naming Convention 
HDF File – ProSoft input or output data file where meta-information and data have been 
organized using Hierarchical Data Format following the principles of data organization 
and processing. 

Instrument File – A calibration (*.cal) file or a telemetry definition file (*.tdf) ( for details 
see Satlantic Instrument File Standard). 

File Nametag – Last letters or numbers which follow underscore ('_') in a file name. 

Level 1 – Binary logged data file with the RAW extension. 

Level 1a – Binary data is extracted from RAW data under the control of the instrument 
(calibration) files. Extracted information is grouped along with its calibration information 
and placed into Level 1a HDF files. File nametag is _L1a. 

Level 1b – Level 1a data is calibrated. If selected, CAL, BIN or NULL dark correction is 
applied. File nametag is _L1b. 

Level 2 – Includes Level 1b data, which is further modified per request basis. File 
nametag is _L2. 

1. Reference and dark data deglitching is applied. 
2. If selected, SHUTTER dark correction is applied. 
3. If a profiler instrument exists, profile editing is performed. 

Level 2s – Level 2 data is interpolated onto a common co-ordinate vector, which is 
either depth (Profiler) or time (Reference only or SAS). File nametag is _L2s. 

Level 3a – Averages level 2s data as defined by level 3 processing parameters 

Level 4 – Data products produced from level 3a data. 

12.2 Optical Sensors 
Ed - Profiler downwelling plane irradiance 

Lu - Profiler upwelling radiance 

Eu - Profiler upwelling plane irradiance 

Ld - Profiler downwelling radiance (special applications only) 

Es - Reference downwelling plane irradiance 

Ls - Reference upwelling radiance 

Ev - Reference upwelling plane irradiance 

Ef - Reference downwelling plane diffuse irradiance (special applications only) 

Li - SAS sky radiance 

Lt – SAS water leaving radiance 

Units: Irradiance - µW/cm2/nm 
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Radiance - µW/cm2/nm/sr 

12.3 Ancillary Sensors 
Tw   – External water temperature (oC) 

Ti     – Internal irradiance sensor array temperature (oC) 

Tr     – Internal radiance sensor array temperature (oC) 

Pres  – Profiler depth (m) 

TiltX  – Sensor tilt on X axis (deg) 

TiltY  – Sensor tilt on Y axis (deg) 

Rtilt  – Reference tilt about vertical axis (deg) 

Ptilt  – Profiler tilt about vertical axis (deg) 

Pitch – Sensor tilt along horizontal axis (deg) 

Roll   – Sensor tilt about horizontal axis (deg) 

Heading – Heading for a ship or an instrument (deg) 

Azimuth – Solar Azimuth angle (deg) 

Elevation – Solar Elevation angle (deg) 

Rotation – Rotation angle for an instrument (deg) 

Cond  – Seawater conductivity (mmho/cm) 

Fluor  – Fluorometer (µg/l) 

Trans  – Transmissometer (/m) 

Comp – Flux gate compass (deg) 

Altim  – Altimeter (distance from bottom) (m) 

PAR  – PAR sensor (µE/m2) 

Time  – System time (decimal hours) 

Vel    – Profiler descent velocity (m/sec) 

Frame  – Instrument frame counter (0..255) 

LuDark – Profiler radiance dark detector OCR-1000 only (counts) 

EdDark – Profiler irradiance dark detector OCI-1000 only (counts) 

EsDark – Reference irradiance dark detector OCI-1000 only (counts) 

LsDark – Reference radiance dark detector OCR-1000 only (counts) 
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13. Appendix B: Instrument Sensor Distances 
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HyperPro II (surface mode) Sensor Dimensions 

0.200 m Lu Distance 
Reference: 
Surface 
 

0.200 m 

Ed Distance 
Reference: Pressure 
0.470 m 

Surface Reference Line ( top of fins ) 

Ed Distance 
Reference: Surface 
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14. Appendix C: Data Formats 
Table 1 File Header 

File Header Units Description 
PROSOFT None ProSoft software version used in analysis 

CRUISE-ID None Identifies the cruise on which the current 
series of log files is taken. 

OPERATOR None Identifies the operator of the data 
acquisition software for the current log 
file. 

LATITUDE Decimal 
Degrees 

Identifies the latitude coordinates of the 
instrument for the current log file. 

LONGITUDE Decimal 
Degrees 

Identifies the longitude coordinates of the 
instrument for the current log file. 

ZONE None Identifies the data acquisition time zone 
of the current log. 

COMMENT None Comment field for ancillary sky and sea 
observations 

STATION-ID None Identifies the station for the current 
series of log files. 

CAST None Identifies the current log file in a series of 
related log files. 

TIME-STAMP None Identifies the time on the data acquisition 
computer as of the beginning of the 
current log file. 

MODE None Identifies the data acquisition software 
mode. 

PRESSURE-TARE Meters (m) Pressure tare taken at the surface for 
current log file. 

TIMETAG None Obsolete. 

DATETAG (YYYYDDD) Switch to include date/time tagging. 

TIMETAG2 (HHMMSSsss) Switch to include timetag2 tagging. 

PROFILER None Identifies the status of the profiler 
instrument. 

REFERENCE None Identifies the status of the reference 
instrument. 

PRO-DARK None Profiler dark correction method. 

REF-DARK None Reference dark correction method. 

PRO-ID None This field is the identifier for the profiler. 
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PROCESSING_LEVEL None Identifies the processing level of the 
current file. 

FILE_CREATION_TIME None Date of file creation. 

DEGLITCH_PRODAT None Switch to include deglitching of profiler 
data. 

DEGLITCH_REFDAT None Switch to include deglitching of reference 
data. 

PRESS_TARE_CORRECTION Meters (m) Pressure tare value applied to current log 
file. 

DEPTH_RESOLUTION Meters (m) Depth resolution used for Level 2s data 
interpolation. 

BIN_INTERVAL Meters (m) Level 3a variable that determines which 
depth interval to average. 

BIN_WIDTH Meters (m) Level 3a variable that determines depth 
range within which to average. 

TIME_INTERVAL Seconds Level 3a variable that determines which 
time interval to average. 

TIME_WIDTH Seconds Level 3a variable that determines the 
time range within which to average. 

WAVEL_INTERP (nm) Level 4 variable that determines 
wavelength interpolation interval. 

INTEGRATION_POINTS None Level 4 variable that determines number 
of data points to use for regression 
analysis. 

REFLECTION_ALBEDO None Reflection albedo value used in level 4 
processing. 

REFLECTANCE_INDEX None Reflectance index value used in level 4 
processing. 

REFRACTIVE_INDEX None Refractive index value used in level 4 
processing. 

Table 2 Level 1-2 Table Descriptors 

Table Label Units Description 
PRES Meters (m) Used to define a pressure sensor measurement. 

Pressure measurements are usually used with 
submersible instruments to gauge their depth. 

ALTIM Meters (m) Used to define an altimeter sensor measurement. 
Altimeter measurement is normally used to gauge the 
distance from a submersible instrument to the ocean 
floor. 
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FRAMECOUNTER None The value of a frame counter is simply a numerical 
counter that can help ensure all frames received are 
sequential. 

CHECKSUM None The value of the check sum is the last byte of the sum of 
all bytes, up to but not including the check sum sensor, in 
a frame of telemetry subtracted from 0. 

INTTIME Seconds Defines the adaptive or adjusted integration time for all 
subsequent optical sensors for which the sensor was 
defined. 

DARK None Some optical sensors are shielded from light exposure to 
establish a dark noise floor for a related optical sensor 
grouping. 

DARK_SAMP None Indicates the number of dark sensors used to calculate a 
dark average. 

DARK_AVE None Defines the actual average dark value. 

T Degrees 
Celsius (°C) 

Used to define a temperature sensor measurement. 
Temperature sensors can be placed anywhere on an 
instrument. 

TILT Degrees Used to define a tilt or attitude measurement for an 
instrument. A tilt measurement is normally used to 
determine the alignment of an instrument with the 
vertical. 

PITCH Degrees Used to define a tilt sensor along the horizontal axis. A 
pitch sensor can be used to determine an instruments 
orientation relative to the horizon. 

ROLL Degrees Used to define a tilt sensor about the horizontal axis. A 
roll sensor can be used to determine an instruments 
orientation relative to the horizon. 

COMP Degrees Used to define a flux gate compass sensor 
measurement. These sensors measure magnetic flux to 
establish a compass direction. 

HEADING Degrees Used to define the heading measurement for a ship or an 
instrument. 

AZIMUTH Degrees Used to define the solar azimuth measurement. 

ELEVATION Degrees Used to define the solar elevation measurement. 

ROTATION Degrees Used to define the rotation measurement for an 
instrument. 

COND (mmho/cm) Used to define a seawater conductivity sensor 
measurement. A conductivity measurement is necessary 
for calculation of salinity. 

FLUOR (µg/l) Used to define a Fluorometer sensor measurement. 
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TRANS (/m) Used to define a Transmissometer sensor measurement. 
A Transmissometer measurement indicates the 
attenuation of a light beam in a given media. 

PAR (µE/m2) Used to define a sensor for measuring photosynthetically 
active radiation. PAR measurements indicate the total 
light energy available for photosynthesis per unit area. 

TIMER Seconds Used to define a timer sensor for indicating the number of 
seconds that have elapsed since the instrument was 
powered up. 

 

Table 3 GPS Table Descriptors 

Table Label Units Description 
UTCPOS None Used to define the Universal Coordinated Time of the GPS frames 

LATPOS Degrees Used to define the latitude coordinates of the GPS frames. 

LONPOS Degrees Used to define the longitude coordinates of the GPS frames. 

LATHEMI None Used to define the hemisphere of the associated latitude 
coordinates. 

LONHEMI None Used to define the hemisphere of the associated longitude 
coordinates. 

SPEED Knots Used to define the ground speed of the GPS frames. 

COURSE Degrees Used to define the course over the ground in degrees true. 

MAGVAR Degrees Used to define the magnitude of the magnetic variation to be used 
between true and magnetic degrees. 

DATE None Used to define the date of the GPS measurements (ddmmyy) 

MODE None Used to define the position system mode for the GPS sensor (i.e. 
A = Autonomous, D = Differential) 

 

Table 4 Level 4 Table Descriptors 

Table Label Units Description 
K_Lu , K_Ed, K_Eu (/m) K values 

Lu(0-), Ed(0-), Eu(0-), Es(0-) (µw/cm2/nm) or (µw/cm2/nm/sr) Surface optical data 

Q(0-) (sr) Q Factor 

Lw-Lu(0+), Lw-Ls(0+) (µw/cm2/nm/sr) Water leaving radiance. 

Lwn-Lu(0+)/Ed(0+), Lwn-Lu(0+)/Es, 
Lwn-Ls(0+)/Es 

(µw/cm2/nm) Normalized water 
leaving radiance. 
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RSR-Lu(0+)/Ed(0+), RSR-Lu(0+)/Es, 
RSR-Ls(0+)/Es 

(/sr) Surface remote sensing 
reflectance. 

RSR-(Lu/Ed) (/sr) Remote sensing 
reflectance profiles. 

RFL-Eu(0+)/Ed(0+), RFL-Eu(0+)/Es (/sr) Surface reflectance’s. 

Profiler Par (µMol/m2/s) Photosynthetically 
available radiation 

Morel 2001 Chlorophyll Profile, 
SeaBAM OC2 Surface Chlorophyll, 
Gordon 88 Surface Chlorophyll 

(µg/l) Chlorophyll Estimates 

Profiler Flux, Reference Flux (w/m2) Energy fluxes 

Water Properties Table Depth (m) 

Temp (°C) 
Conductivity (µmho/cm) 
Conductivity Ratio (None) 

Salinity (psu) 

Density (Kg/m3) 

Water Properties 
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15. Appendix D: Profiler/Reference Data Deglitching Function 

15.1 Background 
Deglitching of optical data measured in sea environment is not a trivial task. Data 
glitches that can be caused by power instabilities, inconsistencies between data transfer 
baud rates and data logging speed, and other reasons that are not caused by changes 
in the natural environment. On the other hand, noise in optical data can be also be 
caused by wave-focusing effects, random changes in profiler's tilts, and the noise 
caused by dark current. 

We make difference between the data glitches and remaining part of unwanted noise 
mainly to make possible differential data treatment depending on the cause of a noise. In 
a case of glitches, we want the respective part of data simply removed. In a case of 
wave focusing, dark current (DC) influence and profiler tilts, one may try to reduce their 
influence by some sort of data filtering. In an extreme case, data with significant tilts, DC 
etc can be also removed. 

15.2 Description of data distribution with depth 
1. Profiler's optical data changes exponentially with depth. Changes in signal values can 
be as large as 8 orders e.g. from 1 to 1e-8. 

2. Part of the data changes that can be regarded as noise, also change significantly. 
Moreover, noise distribution with depth is not homogeneous The causes for noise in the 
different parts of a profiler are different e.g. if in the surface layer wave focusing and tilt 
effects are dominating then with the depth increase, dark current noise contribution 
increases, and finally starts to dominate. 

15.3 Problem 
To identify glitches, one should divide measured data profile (S) into two parts: signal 
(<S>) and noise (E). 

ESS +=       (1) 

where operator <> means some sort of data averaging. From equation (1) it is clear that 

noise definition SSE -= depends on a meaning of operation of data averaging. The 
measurements with E > Threshold will be declared glitches. Mean signal <S> can be 
estimated using various approaches. E.g. FFT, wavelet transform, measured data fit with 
a semi-empirical or empirical model (e.g. simple exponential or polynomial fit), simple 
moving average etc. In all these cases, distribution of E with depth will remain 
statistically inhomogeneous i.e. one could expect that p.d.f of E will change as a function 
of depth. The outlined inhomogeneous error distribution constitutes the main 
problem for glitches identification and their subsequent removal. 
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15.4 Approach for the Problem Solution 
1. We assume that we have data S measured at fixed time or depth interval. For 
simplicity we will use data frame number 'i' instead of a time or space co-ordinate. Thus 
we have 

S(i), where i = 1,…, N, where N is number of measurements 

2. From S(i) we calculate the ratio 

dS(i) = S(i+1)/S(i), i = 1, …, N-1 

3. Sort dS in an ascending order 

dS_sorted = sort(dS) 

4. Calculate a measure of data deviation 

stdS = dS_sorted(n1) - dS_sorted(n2), where 

n1 = 0.2*nn 

n2 = 0.75*nn 

nn = length of dS 

5. Calculate median value of dS 

medN = median(dS) 

6. Find data invalid data values 

| dS(i) – medN | > NoiseThresh*stdS 

The default values for a profiler and a reference instrument are 5 and 20 respectively. 
They should be adjusted according to a concrete situation. 

From Step 6 it follows that all values that lie above NoiseThresh*stdS, should be 
removed. 

15.5 Examples 
Figures 1 and 2 show the examples of measured upwelling radiance signal Lu without 
glitches (Figure 5b) and with glitches (Figure 6b). The position of the vertical red lines in 
the figures 1a, 1c and 2a indicate the levels below or above which data will be declared 
as a glitch.  Figure 5 shows data that had not any glitches in a sense defined above. 
However, one can see that significant part of data dominated by dark noise at the bottom 
of the profile is declared as the glitches. Although, usually this is not a problem to reject 
data dominated by DC, the given example demonstrates a potential problem in making 
difference between different causes of noise. In some cases wave focusing effects 
(practically not visible in the present examples) are also clearly visible in the upper part 
of a profile, and can be easily misinterpreted by a program as glitches in data. For this 
reason, sometimes it could be advantageous to perform data deglitching analysis only to 
some parts of a profile by identifying upper and lower depth boundaries of a profile. The 
deglitching function appended to this document enables a user to define the respective 
boundaries using ProSoft’s configuration file (see the last section of this note). In this 
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way, depending on an aim of deglitching analysis, one could also remove or not touch 
significant amount of data affected dark noise or wave focusing. 
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Figure 8 Distribution of upwelling Lu radiance 
 with depth with no data glitches. (a) Distribution ratio of Lu(i+1)/Lu(i), two vertical red 
lines stay for medN | +/- NoiseThresh*stdS, (b) distribution of Lu as a function of 
pressure, (c) and (d) – the same as (a) and (d) but for downwelling irradiance. 
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Figure 9 The same as Figure 5 (a) and (b) but with apparent data glitches. 
(c) distribution of deglitched Lu as a function of depth. 
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